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Beyond 20/20™ enables economists,
analysts, policy makers and other
nontechnical professionals to quickly
access and view data from different
perspectives.

Beyond 20/20’s pivoting and nesting
capabilities make it easy to switch
dimensions and show more than one
dimension along rows and columns.
In addition, Beyond 20/20’s dynamic
data format enables you to quickly
and easily integrate and manipulate
information from your own data
sources.

Beyond 20/20’s graphs and maps,
especially its unique ChartBrowse™
and MapBrowse™ features, make 
it much easier to examine trends,
cycles and geographic distributions
within the data. As well, the tables
you receive in Beyond 20/20 format
are usually documented with 
metadata to clarify the context of the
information for better understanding
and statistical interpretation.

WHAT IS BEYOND 20/20™?
Beyond 20/20 is time intelligent. 
When working with statistics, 
the analysis of a sequence of 
information measurements made 
at specified time intervals is usually
the dominating dimension of the
data. If you are an analyst or 
economist, you may need to average
or aggregate data into different time
intervals to view annual versus
monthly figures. Beyond 20/20
enables you to compare the 
aggregated figures over a specified
time interval to gain insights into 
the trends and cycles inherent in 
the data.

Beyond 20/20 helps users turn 
information into knowledge.
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This Guide
This QuickStart Guide contains the
information you’ll need to start using
the Beyond 20/20 Browser™ with
data tables or extracts prepared with
the Beyond 20/20 Builder™. For
more details on using the Browser,
see the On-line Help or the Beyond
20/20 Browser User’s Guide.

Beyond 20/20
Concepts
A table is an integrated presentation
of multi-dimensional data and
descriptive text prepared with the
Beyond 20/20 Builder. Tables are
composed of descriptive compo-
nents, dimension field information
and data values. When a table is
opened, the Browser presents the
data in a table view.

A dimension describes an attribute of
the table data, e.g. sex, geography or
time. Beyond 20/20 tables can have
up to ten dimensions.

An item is an element of a dimen-
sion, e.g. June is an item of the time
dimension; and Male, of the sex
dimension.

A label is a title or display heading of
an item. An item can have more than
one label although you see only one
label at a time, e.g. United States is 
a label for the code “U.S.”

An extract is a special type of 
database file that is created with 
the Beyond 20/20 Builder. Extracts 
provide complete data documenta-
tion and are optimized to permit
rapid table creation with the Browser.
You can create a table by opening an
extract, defining the dimensions and
content of the table, and clicking the
Go button on the toolbar.
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GETTING
STARTED
Starting the Browser
To start the Beyond 20/20 Browser,
double-click on its icon. By default,
when the Browser opens, the Find
dialog box appears to provide you
with a quick and easy way to find
and open a table or an extract.

Finding a Table or 
an Extract
1. If you’re not already 

in the Find dialog box, 
click the Find button 
on the toolbar.

2. Confirm or modify the path shown
in the Directory box so that it’s 
pointing to the directory that 
contains the tables and/or extracts
you want to browse.

3. Select the category that most 
likely contains the table or extract 
you need. A list of tables and 
extracts belonging to that 
category is displayed.

Note: If you want to see more 
information about what a particular
table or extract contains, click on its
name and click the Summary button.
You can also use the Search button
to find tables or extracts containing
key words or phrases.
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Opening a Table or
an Extract
Open a Beyond 20/20 table or extract
by double-clicking on its name in the
Find dialog box.

Note: To create your own tables
from an extract, see “Working with
Extracts” on page 16. Once you have
created a table, you may find it use-
ful to refer to “Working with Tables”
on this page.

WORKING
WITH TABLES
Viewing Multilingual
Tables
When a multilingual table is initially
opened, it is displayed in the 
language of preference indicated 
in the Preferences dialog box
(Window menu). To view the table 
in one of its alternate languages,
choose Change Language from 

the View menu. Subsequent selec-
tions of this menu command display
the table in its next available lan-
guage. The status bar indicates
which language you are currently
viewing.

Changing the Table
and User Interface
Languages
Click the Language button
on the toolbar to simultane-
ously change the language
of a multilingual table and the user
interface. Only those languages 
common to both the table and the
interface may be viewed via this 
button. To view additional table 
languages, choose Change Language
from the View menu.

Table Browsing
Once you have opened a table, you
can browse through the items in any
dimension. First you must make the
dimension active by clicking on one
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of the dimension tiles in the
Dimension bar. You’ll notice that the
dimension is now shown in the
Active Dimension box. Click the
Previous Item button or the Next
Item button to browse through the
data for the items in that dimension.
Note that each dimension tile shows
the dimension name and the code or
label of the item for which data is
currently displayed.

Viewing Table,
Dimension and Item
Summaries
Summaries give additional textual
information about the data you’re
viewing.  File summaries explain
what’s in a table, and can be viewed
by selecting Summary from the 
File menu.  Dimension and Item

summaries provide
additional 
documentation specific
to a dimension or an
item. View dimension
summaries by double-
clicking on an under-
lined dimension name.
Similarly, view item
summaries by double-
clicking on an under-
lined item code or
label.
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Switching Table
Dimensions
Once you have opened a table, you
are in the table view. You can change
your view of the table by dragging
and dropping dimension tiles with
the mouse, one at a time. Referring
to the example on page 7, if you
want to see Units
across Time for the
current region, North
America, drag the Units
dimension tile and drop
it on the Region dimen-
sion tile. This shows
the Units dimension
along the rows, with
Time remaining across
the columns.

Nesting Table
Dimensions
You can view more
than one dimension at the same time
along either the rows or the columns
by nesting dimensions. Nesting
means showing one dimension 

within another. With the left mouse 
button depressed, slowly drag the
desired dimension tile from the
Dimension bar to the top or bottom
edge of the column labels, or to the
right or left edge of the row labels,
until a thick line (or highlight)
appears. Release the mouse button
to nest the dragged dimension.

In the previous example, the Units
dimension tile is dragged until it hits
the right edge of the row labels and

the highlight appears.
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The left mouse button is released,
and the Units dimension is nested
inside the Region dimension.

Selecting Data from
a Table
To reduce the amount of displayed 
data, to move data to another 
application, or to chart or map 
data, you first need to select it.

• To select a row or a column of 
data, click on the corresponding 
row or column heading.

• To select multiple 
consecutive rows 
or columns, drag 
the mouse across 
the row or column 
headings.

• To select non-
adjacent rows 
and/or columns, 
press the Ctrl key 
while you click on 
the row and/or 
column headings.

With your selection highlighted, click
the right mouse button for the short-
cut menu, then select the desired
operation. You can show, hide, chart,
copy or print the selected items.
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Displaying Alternate
Item Labels
Frequently there is more
than one set of labels avail-
able for the items in a
dimension. For example,
there may be a short label and a
longer more descriptive label. 
To view the next set of labels for 
a dimension:

1. Make the dimension active by 
clicking on the appropriate 
dimension tile.

2. Click the Change Labels button 
on the toolbar.

Searching for Items
Along a Dimension
You can reduce the items
shown along a dimension by
displaying only the ones you
want. To search for items
along a dimension:

1. Make the dimension active by 
clicking on the appropriate 
dimension tile.

2. Click the Search Dimension 
button on the toolbar.

3. In the Search dialog box, select 
the Data field if you want to 
search the data, then enter 
minimum and/or maximum values
to constrain your search. When 
you click OK, Beyond 20/20 
searches the active items and 
shows only those items that have 
satisfied your criteria.

OR
In the Search dialog box, 
select the non-data field you want 
to search, then enter the text 
string that you want to search for 
in the Text to Find box. When you 
click OK, Beyond 20/20 searches 
the field you selected and shows 
only those items that contain the 
text string specified.

Note: To jump to a desired item 
along a dimension, choose Find   
Next.
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Sorting Data Across
a Dimension
You can sort items across a
dimension to reorder them in
the table view. To sort items
across a dimension:

1. Make the dimension active by 
clicking on the appropriate 
dimension tile.

2. Click the Sort Dimension button 
on the toolbar.

3. If you want to sort the dimension 
based on the data values, select 
the Data field in the Sort dialog 
box. Then select either Increasing 
or Decreasing, and click OK.

OR
If you want to sort the 
dimension based on the codes or 
labels associated with it, select the
non-data field that you want to 
sort, then indicate the Sort Option 
and click OK.

Changing the
Frequency of the
Displayed Data
Many tables use time as a 
dimension. You may want to
decrease the display frequency by
aggregating the data. For example,
if your table contains monthly
data, you can average or sum the
monthly values to produce annual
data. To change the frequency of
displayed table data:

1. Choose Time Series from the 
View menu.

2. Select the desired Display 
Frequency.

3. Select the Aggregation Method 
you want Beyond 20/20 to use 
to compute the new data.

4. Click OK.
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Creating Percentage
Distributions
You can display numeric values 
distributed as percentages of row,
column, or table totals.

1. Choose Distributions from the 
View menu.

2. Select those dimension(s) you 
want to include in the distribution 
calculation. Note that the row and 
column dimensions are 
automatically included in the 
distribution calculation.

3. Clear any check boxes for those 
items you want to exclude from 
the new distribution dimension.

4. Click OK.

Beyond 20/20 creates a new table
view with a new dimension called
Distributions. This dimension 
contains one item for each type 
of distribution you’ve selected.

Performing
Calculations
You can apply formulas to items in 
a dimension to create a computed
group. For example, you can sum
two items together and divide the
result by two.

1. Choose Define Group from the 
Item menu.

2. Enter a unique name or group 
code to represent the result of the
formula.

3. Choose the Computed Group 
Type.

4. Enter a formula to describe how 
the new group is to be calculated.
For example, (item1+item2)/2.

5. Click OK and proceed with the 
calculation of the group.
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Saving and Opening
Views
A saved view is a personalized snap-
shot of a table that allows you to
quickly recall a specific layout of a
table without having to redefine its
attributes. Dimension order and
nesting, item selections, column
widths, decimal settings and time
series aggregations are all examples
of attributes that are stored in a
view.

• To permanently change the default
view of a table, you must have 
permission to modify the table. 
Arrange the table in the layout you
wish to save and choose Save 
from the View menu. The next 
time you open the table the saved 
view will automatically appear.

• If you are in a read-only table or 
you don’t want to permanently 
modify the default view of a table:

1. Arrange the table in the layout 
you wish to save.

2. Choose Save As from the File 
menu and clear the Include 
Numeric Data check box.

3. Name the view and specify its 
location.

4. Click OK.

A view saved in this fashion 
can be recalled by choosing 
Open from the View menu and 
selecting the view filename. 
This method of saving a view 
can also be used to save 
multiple views for one table.
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Charting Data
You can choose from many
chart types to display table
data. To create a chart:

1. Select the rows and/or columns 
that you want to chart.

2. Click the Display Chart button on 
the toolbar.

3. With the mouse pointer in the 
chart view, click the right mouse 
button to see the Charting short
cut menu and choose Chart 
Options to change the current 
chart type.

4. Make a selection and click OK to 
return to the chart view.

ChartBrowse
The ChartBrowse feature lets you
view a series of charts in rapid suc-
cession so that you can quickly and
easily see trends and variations in
the data.

1. With the mouse pointer in the 
chart view, select one of the 
headings in the title of the chart 
to make that dimension active.

2. Use the Previous Item and Next 
Item buttons on the toolbar to 
chart the previous or next item.

Mapping Data
Some tables have a geograph-
ic dimension that has a map
associated with it. To view the
table data within its geographic 
context:

1. In a table view, move the cursor 
to the item that contains the data 
you want to display on a map.

2. Click the Display Map button on 
the toolbar.
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Zooming In and Out
of a Map View
To zoom in to a region on a map,
double-click on the region or the
value representing that region.

To zoom out to a higher level on a
map, double-click on the white space
inside the map border.

Changing Map
Colors
1. With the mouse pointer in the 

map view, click the right mouse 
button to see the Mapping 
shortcut menu.

2. Choose Map Options.

3. Click the button in the Range 
Definition area that corresponds 
to the preferred method of data 
classification.

4. Use the Range Colors pop-down 
menus to select the colors that 
you want to appear on your map.

MapBrowse
The MapBrowse feature lets you
view a series of maps in rapid suc-
cession for data tables that support
mapping. This feature provides a
quick, easy way to view the trends
and variations of the data.

1. With the mouse pointer in the 
map view, click on one of the 
headings in the title of the map to 
make that dimension active.

2. Use the Previous Item and the 
Next Item buttons on the toolbar 
to display the previous or next 
item on the map.
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Printing a Table,
Chart or Map
To print a table view, chart view, or
map view, click the right mouse 
button to see the shortcut menu and
select the Print option.

Saving a Table
To save a table (or a subset of one)
as a new Beyond 20/20 table,
choose Save As from the File menu.
You can also save Beyond 20/20
table data in several other for-
mats including, dBase (.dbf),
comma-separated value
(.csv), and Lotus (.wks).
When saving to any non-
Beyond 20/20 format, you’ll
need to nest all the dimen-
sions along the rows and/or
columns before you save if
you want to retain the data
for these dimensions (see
“Nesting Table Dimensions”
on page 8).

WORKING
WITH
EXTRACTS
When you open an extract (see
“Opening a Table or an Extract” on
page 6), the Browser displays an
empty table view and the Source
Field bar – a list of source field tiles
down the right side of the screen.
Each source field tile represents one
of the fields in the original data file.
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Viewing Extract and
Source Field
Summaries
An extract summary contains 
descriptive information about the
extract and lists the attributes of 
the extract. Choose Extract Summary
from the Data menu to view the
summary information.

A source field summary contains
descriptive information about a 
particular source field. To view this
information right click on a source
field tile and select Source Field
Summary.

Finding Source
Fields
Source fields are the components of
an extract. When positioned into an
empty table view, they become the
dimensions of a table or define the
content of the table. Often you have
a large number of source fields to
work with and you need a way to
find specific fields. 

The Find Source Field dialog box
helps you do this.

1. Choose Find Source Field from the
Data menu. Initially, all categories 
and consequently all source fields 
are displayed.

2. Locate a particular field by 
searching for the field using the 
Search button or by selecting 
individual categories that may 
contain the source field you are 
looking for.

3. Once you have found a specific 
source field, select it and click OK.
In the Source Field bar the 
Browser will position the cursor 
on the selected field.
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Defining the
Dimensions of a
Table
Define the dimensions of a table by
dragging your choice of source field
tiles, one at a time, into the row and
column dimension areas.

1. Drag a source field tile into the 
row dimension area. You’ll see 
that the Browser highlights the 
area where the tile can be 
dropped.

2. Drag a second tile into the column
dimension area.

3. Drag up to eight more source field
tiles into the Dimension bar.

Tip: If you make a mistake, drag 
the tile back to the Source Field bar.
Or, you can replace a dimension by
dragging and dropping a new source
field tile onto it.

Filling a Table with
Units
If you want the table to be filled with
counts, you can create the table by
clicking the Go button on the toolbar.
However, you may want to have
other data values aside from counts
in the table. Just drag and drop tiles
associated with numeric values into
the cell area of the table view.
Beyond 20/20 creates a new dimen-
sion called Units containing one item
for each tile you move into the cell
area. As you drop the tiles, Beyond
20/20 lets you choose which statisti-
cal value related to the source field
will be used to fill the table. For
example, you can choose sums,
averages, or minimum or maximum
values.
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Creating a Table
Once you’ve defined the table,
create it by clicking the Go
button on the toolbar.

Saving a Table
To save your table for future use:

1. Choose Save As from the File 
menu.

2. Enter up to eight characters to 
name the table.

3. Click OK.

Documenting a Table
1. Choose Summary from the Edit 

menu, then choose File.

2. Enter a Title and Category — 
these will appear in the Find 
dialog box.

Applying a
Weighting Factor to
the Data
If you are working with an extract
that represents data collected from a
survey there will probably be at least
one field that contains weights.
These weights are used to generate
population-based tables from sample
survey data. An extract is pre-
weighted if one of the weight fields
is greyed out in the Source Field bar.
Tables built from a pre-weighted
extract will automatically contain
weighted values. To set a weight field
or to clear or change a previously set
weight:

1. Choose Set Weight Field from the 
Data menu.

2. Select or clear the Use Weight 
Field check box and if selected, 
click on the numeric source field 
that you want to use as the weight
field.

3. Click OK.
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3. If you wish, enter Keywords to 
help you find the table later, and 
Notes to provide additional 
information.

4. Click OK.

Note: After you save and close the
table the extract view reappears and
you are ready to build another table.

Exporting an Extract
Data from an extract can be saved to
dBase, SAS, or SPSS file formats.

1. Choose Save Extract As from the 
File menu.

2. Enter a new file name and, if 
necessary, select a different drive 
or directory.

3. Select the type of file you want to 
save.

4. Click Save.

The Export Extract dialog box 
appears.

5. Select which source fields you 
want to export.

6. Click OK.
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Other Table Creation
Features
The Data menu contains commands
that you can use to further 
customize your table.

The Define Recode command lets
you create a new source field tile 
based on an existing coded field 
such as occupation or marital 
status. Use this feature to 
combine items from an original 
source field. For example, for the 
source field Marital Status, the 
codes for Single, Divorced and 
Widowed could be combined to 
form a new code called 
Unmarried.

The Define Bands command lets 
you create a new source field tile 
based on an existing numeric 
field. Use this feature to redefine 
the default bands of an existing 
source field. For example, if Age is
a source field, then you may wish 
to change five-year bands to 
ten-year bands.

The Define Derived Field
command lets you create a new 
source field tile using arithmetic 
operations on one or more 
existing source fields. For 
example, given Net Income and 
Taxes as two source fields, you 
can add them to create a new tile 
called Gross Income.

The Record Constraints command
lets you create a table subject to 
certain criteria or constraints. For 
example, if Sex and Age are two 
of your source fields, you could 
create a table that contains data 
only for females between the ages
of 15 and 24.

See the On-line Help or the Beyond
20/20 Browser User’s Guide for further
information on how to use these
commands.

For the most up-to-date edition of
the online Quickstart Guide, please see
the Ivation website at
www.ivation.com.





You’ll find the Beyond 20/20
Browser very simple to learn and
use. Within minutes, you can quickly
and easily:

Browse multi-dimensional tables

Find data tables and extracts by 
category

Search tables and extracts by 
keyword

Work with several tables at once

Switch and nest data dimensions

Aggregate time series data

Select and hide data

Search and sort data

View data distributions

Save views

Perform calculations

Read descriptive information 
about the table or extract

ChartBrowse™ and MapBrowse™

Zoom in and out of maps

Print tables, charts and maps

Copy tables, charts and maps to 
other Windows applications

Save tables in numerous formats

Create your own data tables from 
Beyond 20/20 Extracts

View multilingual tables in the 
language of your choice

Beyond 20/20 Browser Features
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